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Thank you for purchasing our product. If there are any questions, or requests, pleams desitate to contact
the dealer.

Copyright

Copyright 20%-2017 Zhejiang Uniview Technologies Co., Ltd. All rights reserved. No part of this manual
may be copied, reproduced, translated, or distributed in any form or by any means without prior consent in
writing from our company.

Trademark Acknowledgement

UNV and other Univievs trademarks and logos are the property of Zhejiang Univieghnologies Co.,

Ltd. Other trademarks, company names and product names contained in this manual are the property of
their respective owners.

Disclaimer

@ CAUTION

The default password is used for your first login. To ensure account security, pleaseectine
password after your first login. You are recommended to set a strong password (no less thi
characters).

To the maximum extent permitted by applicable law, the product described, with its hardware,
software, firmware and documents, is progiion andas ig basis.

Best effort has been made to verify the integrity and correctness of the contents in this manual, but
no statement, information, or recommendation in this manual shall constitute formal guarantee of
any kind, expressed or implietVe shall not be held responsible for any technical or typographical
errors in this manual. The contents of this manual are subject to change without prior notice. Update
will be added to the new version of this manual.

Use of this manual and the subsequeasult shall be entirely on the ug@rown responsibilityln no

event shall we be reliable to you for any special, consequential, incidental, or indirect damages,
including, among others, damages for loss of business profits, business interruptiors of teta or
documentation in connection with the use of this product.

Video and audisurveillancecan be regulated by laws that vary from country to coun@yeck the

law in your local region before using this product grveillancepurposes.We shallnot be held
responsible for any consequences resulting from illegal operations of the device.

The illustrations in this manual are for refererar@y and may vary depending on the versionmodel

The screenshots in this manual may have been customtpetheet specific requirements and user
preferences. As a result, some of the examples and functions featured may differ from those displayed
on your monitor.

This manual is a guide for multiple product models aadtis not intended for any specific pradt.

Due to uncertainties such as physical environment, discrepancy may exist between the actual values
and reference values provided in this manual. The ultimate right to interpretation resides in our
company



Environmental Protection

This product has len designed to comply with the requirements on environmental protection. For the
proper storage, use and disposal of this product, national laws and regulations must be observed.

Symbaos

The symbols in the following table may be found in this manual. @rdbllow the instructions indicated
by the symbols to avoid hazardous situations and use the product properly.

Symbol Description

C Contains important safety instructions and indicates situations that could cause b

@ Means reader be careful and impropgperations may causelamage or malfunction
CAUTION! to product

@NOTE! Meansuseful or supplemental information about the use of product.
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1 Network Connection

Before accednsg a network camergalso known as IP Camera or IFGnN a PC, you need to connect the
network camera to the P@irectlywith a network cable or via a switch muter.

’ Network cable

IPC

P

Use a Shielded Twisted Pair (STP) cable to connect the network intanfabe network camera and the
PC.

Network cable Network cable
) N
WS
IPC Switch or Router PC

Use Shielded Twisted Pair (STP) cables to connect the network interfaces of the camera and the switch o
router.

2 Login

Preparation

After you have completed the installation in accordance whthquick guide, connect the camera to power
to start it. After the camera is started, oy canaccess the camera from a PC client installed withea
browser or the client software EZStationtdmet Explorer(IE)is a recommended web browser. For more
information about EZStatigmefer to theEZStation User Manual

The following takesEon aMicrosoft Windows7.0operating systenas an example.
Check before login
The camera isperatingcorredly.
The network connection betweethe PC and the camera is normal.
The PC is installed with Internet Explorer 8.0 or higher.
(Optional) The resolution is set to 1440 x 900.



Add the IP addresas atrusted site
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| &[4 | x || £ 8ing L~

M-
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v pager ety ~(Tonk @

Diagnose Connection Problems...

[ B

Recpen Last Browsing Session

Pop-up Blocker ’

el [

Manage Add-ons

Work Offline
Compatibility View
Compatibility View Settings

algs

Full Screen F11
Toolbars »
Explorer Bars ’

iz Developer Tools F12

Suggested Sites

%( Internet Options ) 9

Internet Options - @u Trusted sites W — — (2 )
Gm Evacy I okt l Conpctiorn I Eyigran I Ao I You can add and remove websites from this zone. All websites in
/' this zone will use the zone's security settings.
Seled a zone to view or change security sethngs
Add this website to the zone:
mma Loca,m“et Remed (http/192.168.0.13 | ad )
Trusted sites Stes I Webmice: @
This zone contains websdes that you 2 Remove
trust not to damage your computer or 9 (4
your files.
You have websites in this zone.
—~ Security level for this zone Y.
Allowed levels for this zone: Al |71 Require server verification (https:) for all sites in this zone)
- | - Medium
% 5 - Prompts before downloading potentially unsafe content
. _]_J - Unsigned ActiveX controls will not be downloaded Qear the check box =
) l (6)

[~ Enable Protected Mode {requires restarting Intemet Explorer)
Custom level... Default level I

Reset all zones to defautt level I

@C o« ) Cancel | sy |



= NOTE!
ThelP address 192.168.0./132.168.1.13in this examplds the default IP addresPlease replace it with tt
actual address of your camera if it has been changed.

(Optional) Modify useraccesscontrol settings
Before you accedbe camera,follow the steps to seUser AccountControl Settinggo Nevernotify.

r = [P .
%) User Account Control Settings [ESSE=l™
i &3 )=[E <« AllControl Paneltems » User Accounts
O & » Control Choose when to be notified about changes to your computer
= Control Panel Hi
Sl Make changes to your user accoun User Account Control helps prevent potentially harmful programs from making changes to your computer.
Adjistyourcomput el me more about User Account Control settings
u; Manage your credentials
Change your picture
Link online IDs Always notify
e ace vourtile enmpmng (-’, Change User Account Control sertmgs) _ - i 5 s
Ac - certificates & Manage User Accounts ever notify me when:

¥ Action Center B Manage User Accounts

) Configure advanced user ®  Programs try to install software or make changes to

# Backup and Restore profile properties my computer

To change your password, press Ctrl+ Alt+Del | - -

[@ Credential Manager Change my environment ® Imake changes to Windows settings

¥ 5eskicn Estind variables

ki Desktop Gadgets
B Display \ = =
B " -
I| & Folder Options @ Not recommended. Choose this only if you need to
use programs that are not certified for Windows 7
@ HomeGroup @ because they do not support User Account Control.
(£] Java
Never notify

F Mouse

M Performance Informati

3 Power Options

& Recovery - Y

2 | e @ok | ) cancel

% Sound

18 System

G @
ws Defender
& Windows Update
L

Loggingln to the Web Interface

The default static IP address of the camera98.1681.13or 192.168.0.13and the default subnet mask is
255.255.255.0.

DHCP is turned ooy default If a DHCP servérusedin the netvork, the IP address of your camera may
be assigned dynamicallgnd you need to use the correct IP address to logsethe EZXStationclient to
viewthe dynamiclP addres®f your camera

The following takes IE as an example to describe the fogitedure.
1. Browse tothe login page by entering theorrect IP address of your camera in the address bar.

‘I ﬁ Failed to load ActiveX control, clic' ‘o install latest ActiveX control. AH

2. |Ifyoulog in for the first time, follow system prompts amktall the ActiveXYou need to close your
browser to complete the installation.

= NOTE
To manuallyload the ActiveX type http:// IP addres#\ctiveX/Setup.exdn the address baand pres
Enter.
Thedefault password is used for your first login. To ensure account security, please change the p
after your first login. You are recommended to set a strong password (no less than eight character
The camera protects itself from illegal access by limitirggnumber of failed login attemptdf login fail:
six times consecutively, the camera locks automatically for ten minutes.




3. Enter the username and passworahd then click.ogin For the first loginusethe default username
cadmire and passwordl2345&.
If you log in withLive Viewselected, live video will be display&hen you are logged irDtherwise,
you need to start liveideomanuallyin the live view window

If you log in withSave Passwordelected,you do not need to enter the password eatitne when you
log in To ensure security, you are not advised to sefate Password

To clear thedsernameand Passwordext boxes and th&ave Passwordheckbox, clickReset

Introduction to theWeb Interface

By default the live view window is dispéa/when you are loggedin to the Web interface. The following
shows an example.

No. Description

1 Menu

PTZ control area

2 Note:
This area is available for PTZ dome cameras and PTZ cameras.

3 Live view window

4 Live view toolbar

Initial Configuration

After you log in to the device, please perform the followingjial configuration

Item Description

Reconfigurethe device IP and network parameters based

1. Setthe TCP/IP address for the devic the actual networking

2. log out and log iregainto the Web
using the new IP address




ltem Description

3. Set the system time Set the system time based on the actual situation

4, (Optiona) Set the management
server

St the management server based on the actual networking

5. (Optiona) et the server for storing Set the server for storing photos based on the act
photos networking

Set the information displayed on the screen as needed,

6. SetOSD )
E— example, time

Change the default password and adcbmmon users as

7. (Optional)Manage users needed

Youcan watch the live videafter finishingthe initial configuration Please configure other parameters as
needed.

= NOTE
Thedisplayed live view interfaggarameters displayed and value ranges may vary with nsoédtas
see theactualWeb interfacefor details
The parameters that are grayed out cannot be modified. Fomatttaal settings, see the Web interface.

It is recommended that you change the passwuaitten you are logged in the first tim&or detas aboul
how to change a passworgleeSacurity.

3 Configuring Parameters

Local Parameters

Set local parameters for your PC.

@ NOTE!

Thelocal parameters may vary with modeRleasesee the actual Wemmterface for details.

1. SelectSetup>Common> LocalSettings



Intelligent Mark

Untriggered Target Dizable |E|
Video
Processing Mode Fluency Priority E
Protocal TCP =
Audic
Enceding Format G711 E

Recarding and Snapshet

Recording

Subsection By Time |E|

Subsection Time [min) 30

When Storage Full

Total CapacitylGB) 10
Local Recording TS
Files Folder CAIPCY

[1-60]

@ Overwrite Recording = S3top Recording

[1~1024]

Browse...| | Open

2. Modify the settings as required. The following table describes some major parameters.

Parameter Description
Intelligent | Untriggered When enabled, theamera willdisplay an orscreen marlon the target(e.g.,
Mark Target face when face detection is enableah)d trackit.
ReaiTime Priority: Recommended if the network is in good condition.
Processing Mode - Fluency Priority: Recommended if )fou want short tlmg !ag forvweo.
Video Ultra-low Latency: Recommended if you want the minimum time lag
live video.
Protocol Set the protocol used to transmit media streams to be decoded by the Pt
Subsection By Time: Duration of recorded videoeiach recording file or
. the computer. For example, 2 minutes.
Recording . . . L
Subsection By Size: Size of each recording file stored on the compute
Record example, 5M.
and Overwrite: When the assigned storage space on the computer is use
Snapshot R q the camera deletes thexistingrecording files to make room for the ne'
ecord recording file.
Overwrite . .
Full Stop: Whenhe assigned storage space on the computer is 1
recording stops automaticall
3. ClickSave



Network Configuration

Ethernet

Modify communication settings such as the IP address for the camera so that the camera can communicate
with other devices.

2 NOTE
After you have changed the IP addregsy need tause the new IP address kog in.

The configurations dDNS(Domain Name Systenserver are applicablevhen the device isccessed t
domain name.

StaticAddress
1. ClickSetup>Network >Network.

Obtain IP Address Static =
IP Address 203.3.1.99
Subnet Mask 255.255.255.0
Default Gateway 203.3.1.1
IPv6
IPv6 Mode Manual =
IPv6 Address
Prefix Length 64

Default Gateway

MTU 1500
Port Type FE Port
Operating Made Auto-negotiation =

2. SelectStaticfrom the Obtain IP Addressdrop-down list.

Enter the IP address, subnet mask, and default gateway addvies® surethat the IP address of the
camerais unique in the network.

4. ClickSave
PPPoE

@ NOTE!

This function is not supported by some modé¥easesee the actual model for details.

If the camera is connected to theetwork through Point to Pointwer Ethernet (PPPoB)ou needo select
PPPolas thelP obtainment mode.

1. ClickSetup>Network >Network.



Obtain IP Address PPPOE ||

Username user

Password TIITITITI I IIITITILLY
IPvE

IPvE Mode Manual [=]
IPvE Address

Prefix Length 54

Default Gateway

MTU 1500
Port Type FE Port
Ogerating Made Auto-negotiation =]

2. SelectPPPoBErom the Obtain IP Addressdrop-down list
3. Enter the username and passwaotbvided by youinternet ServiceProvider (ISP)
4. ClickSave

DHCP

The Dynamic Host Configuration Proto@HCP)s enabled by default when the camera is delivered If

DHCP server is deployedtie network, the camera can automatically obtain an IP address from the DHCP
server.

To manually configure DHCP, follow the steps below:
1. ClickSetup>Network >Network.

Obtain IP Address DHCP =
IPvE
IPv6 Mode Manual =]
IPvE Address
Prefix Length 54

Default Gateway

MTU 1500
Port Type FE Port
Operating Made Auto-negotiation =

2. SelectDHCHrom the Obtain IP Addressdrop-down list

3. ClickSave
IPv6
1. ClickSetup>Network >Network.
IPué
IPvE Made Manual [=]
IPv6 Address
Prefix Length 64

Default Gateway



2. Bydefaultthe IPw6 mode is set taManual.
3. Enter the IPv6 address, set the prefix length and default gateway. The IP address must be unique or
the network.
4. ClickSave
Wi-Fi
= NOTE!
This function is not supported by some models, plesesethe actual model for details.
1. ClickSetup>Network >Network. Click thewi-Fitab.

Wi-Fi Mode Sniffer =
2. SelectSniffer.
3. ClickSave

Port

5 NOTE!
This function is not supported by some modéMeasesee the actual model for details.
1. ClickSetup>Network >Port.

HTTP Port 20
HTTPS Port 443
RTSP Port 554

Mete: Modifying the RTSF or server port number will cause the device to restart.

2. Configure relevant port numbers.
3. ClickSave

FTP

After the configuration of FTP, you will be able to upload snapshots from network cameras to the specified
FTP server.

General
1. ClickSetup> Storage>FTP Go toGeneraltab.



Server Parameters

Server [P 192.168.0.150 Upload Images

Port Mo. 21 Overwrite Storage

Uszername Owverwrite At(image) 1000

Pazzword

Snapshot Image

Save To
Root Directory

- Disable [+] W |Disable [=| ' |Disable [#] W |Disable [=]
File Mame
Separator |- |z|

Ma. MNaming Element

1 None |Z|

2

m | »

3
4
5

2. Set the IP address and portrfthe FTP server, username apasswordused to upload images tine
FTP servesselectUpload ImagesOverwrite Storageand setOverwrite At (threshold for overwriting
images.

3. Set the pathfor saving snapshots on the FTP server and the file name format.

4. ClickSave

Smart

This function is usetb store snapshat taken for smart functions such as face recognition and people

counting.

1. ClickSetup> Storage> FTRGo toSmarttab.

Server Parameters

Server [P 192.168.0.150 Plate Separator

Fort No. 21 Direction ID 1
Username Mot Upload Pictures

Password Custom Maming Rules

Device Mame Convert Path into UTF8 Format
Device ID 1

Intersection ID

Photo of Passing Vehicle

Save To
Root Directory
L None |z| W |Mone |Z| W | Mone |E|
File Name
Separator |- Izl
Mo. Maming Element MNaming Rule
1 Mone [=] -
3 =
3
a4

5

2. Set the IP address and port of the FTP server, username and passseardoupload images to the
FTP server.

3. Set the path for saving snapshots on the FTP server and the file name format
4. ClickSave

10



EMalil

After the configuration of #nail, when alarms are triggered, you will be able to send messages to the
specified Enailaddress.

1. ClickSetup>Network >Email.

Mame

SMTP Server

| |

Address | |
| |

|

SMTF Port 25

TLS/SSL () On (@ Off

Snapshot Interval(s) | 2 v| [+ Attach Image

server Authentication ®On () Off

Username | |

Passwaord | |

Recipient

Mamel

Address1

Address2

Mame3

| |
| |
Mame2 | |
| |
| |
Address3 | |

2. Configure relevant parameters of the sender and the recipient
The following table describes some major parameters.

Parameter Description

When enabled, the -enail will beencrypted using TLS (Transpbeyer Security) or Secul
Socket Layer (SSL) to protect privacy.

First it tries tosend throughan SSL connectioitf the SMTP server supports SSL, thenall
will be sent through the SSL connection; otherwistjes to send using TARTTLS.

TLSESL

When enabled, the enail will contain 3 instant snapshots as attachmantordingto the

Attachimage Capture Interval.

3. ClickSave

Port Mapping

1. ClickSetup>Network >Port. Go toPort Mappingtab.

11



Port Mapping i On i@ Off

Mapping Type Manual |E|
Port Type External Port External IP Address | Status
HTTF Port 20 0000 Inactive
RTSP Port 554 0.000 Inactive
Server Port &1 0000 Inactive

2. EnablePort Mappingand select mapping type. Manual is selected, then external ports must be
configured (external IP is obtained automatically by the camera). If the configured port is occupied,
then the Statuswill show Inactive.

3. ClickSave

DNS

1. ClickSetup>Network >DNS

Preferred DNS Server EEEE |

Alternate DMS Server (3.5.4.4 |

2. Set DNS server addresses.
3. ClickSave

DDNS

E@ NOTE!

This function is not supported by some modétteasesee the actual model for details.

1. ClickSetup>Network >DDNS

DDMS Service (%) On () Off

DOMS Type
NO-1FP
Server Address EZDDMNS

Domain Mame

| |

Usernams | |

Password | |

Confirm | |

2. EnableDDNS Service
3. Select a DDNS typBynDNS, N@P, or EZDDNS.
4. Complete other settings includirsgrver addressjomain name, username and password.
5. ClickSave

12



EZ®ud

@ NOTE!

This function is not available to all models.
This functionis displayed aB2Pfor some devices

1. ClickSetup>Network >EZCloud

EZCloud Cin i OFF

Address en.ezcloud.uniview.com
Register Code 12345673590123456789012345
Device Status Cffline

Scan

2. SelectOnto enable cloud service.
3. ClickSave

802.1x

802.1x provides authenticatiomo devices(e.g., camerg trying to connect to a network. Only the
authenticateddevicescanconnect the networkThis enhances security.

1. ClickSetup>Network >802.1x

802 1x @ On = Off

Protocol

P

EAPOL Version

4]

Uzername
Password

Confirm

2. SelectOnandthen completeother settings
3. ClickSave

Image Configuration

Image Adjustment

@ NOTE!

The image parameterdisplayedand value rangeallowed may vary with camera model. For the ac

parameters and value range$ your camera, see the Web interfacéou may move the slide to adjus
settings or enter values ithe text boxes directly.

ClickingDefaultwill restore all the default image settings.

13



Setting the Scene
Set image parameters to achieve the desired image effects based on live video in different scenes.
ClickSetup>Image>Image

The scene manageent page forsome modelds displayed afollows, you can select the desired scene in
the drop-down list.

5cen8|lndnor V|

The scene managememageof some models is displayed fidlows, you can take the following steps to
configure the scene.

T Seenes
Ma. Curre..| Scene Name Auto Switching Setup
1 a@ =Common= |E| Default Scene
2 <Common: [»] &
3 <Common= |E| <
4 =Common:= [=] <
5 <Common:= [=] e

Current lllumination: 58 l..:"r Current Elevation: 29° I.:F

Enakble Auto Switching

ClickScenes

Select a scene, and then set scene switching parameters. The following table describes some majol
parameters.

Column Description

Indicatesthe scene that is being used.

Note:

Current . Select an option button to switcto the scene and display the corresponding ime
parameters for the scene.

The camera switches the current scene automatically wheable Auto Switchings
selected.

Name of the current scene. The device provides several preset scene nWgtes. you
select a scene, the corresponding image parameters are displayed. You can adjusi
settings according to actual needs.

Common recommended for outdoor scenes

Indoor: recommended for indoor scenes
SceneName . HighSensitivity recommended for low lightnvironment

Highlight Compensationcan suppress strong lightuch as headlights on roads al
spotlight in parksRecommended for capturingehiclelicense plates.

WDR: recommeded forscenes with higitontrast lighting, such as window, corridol
front door or other scenes that are bright outside but dim inside

Custom set a scen@mameas needed

AUto Indicates whether to add a scene to the atswitching list.

Switching Note:
If Auto Switchingis selected, the system switches to a scene automatically when

14



Column Description

condition for switching to the scene is met. By default the aguatching list includes the
default scene.

Click =" to set conditions for auteswitching, including schedule, illunaition, and current
elevation (angle between the PTZ and the horizontal direction). It means

Setup auto-switching is triggered only when illumination and the current elevation during the
time period meet the set conditions. A condition is invalid if bthte start and end value:
are setto 0.

3. Select a scene and then cligk to set it as the default scene.

4. If auto-switching is enabled, the camera can switch to the scene automatically when the condition for
switching to a nordefault scene is metOtherwise, the camera remains in the default scene. When
auto-switching is not enabled, the camera remains in the current scene.

5 NOTE!
If Auto Switching is enabled (scene settings will be unavailable), the device will switch between
scenes. If np the device will stay at the current scene. The device will stay at default scenes unl
non-default scenes are triggered.
If multiple nondefault scenes are triggered, then the device will switch to the scene with the mir
number (starts from 1o 5).

Image Enhancement

@ NOTE!

This function may vary with modeBleasesee actual Web interface for details.

1. ClickSetup>Image>Imageand then clickmage Enhancement

Default

~ Image Enhancement

Brightness 128 20 Moise Reduction 128

Saturation 128 3D Moise Reduction 128

Contrast 128 Image Rotation Normal [«]

Sharpness 128

2. Use the sliders to change the settings. You may also enter valivestly. The following table
describes some major parameters.

ltem Description

Set the degree of brightness of images.

Brightness

Low brightness High brightness

Saturation The amount of a hue contained in a color.

15



ltem Description

Low saturation Highsaturation

Set the degree of difference between the blackest pixel and the whitest pixel.

Contrast
Low contrast High contrast
Contrast of boundaries of objects in an image.
Sharpness
Low sharpness High sharpness
2D . Noise Reduce the noise of imagefhe function may cause image blurring.
Reduction
3D Noise| Reduce the noise of images. The function may cause motion blur (or ghosting in
Reduction applications)
Rotation of the image.
Image
Rotation

Flip Vertical

16



Item

Description

90° Clockwise 90° Anti-clockwise

3. To restore default settings in this area, clid&fault.

Exposure

@ NOTE!

This function may vary with modelBleasesee actual Web interface for details.
The default settings are scem@aptive.Use default settings unless modification is necessary.

1. ClickSetup>Image>Imageand then clickExposure

T Exposure
Exposure Mode
Shutter(s)

Gain

Slow Shutter
Slowest Shutter
Compensation

Metering Contral

Automatic |Z| Day/Might Mode @ Automatic i Day ] Might
1/100 Day/Might Sensitivity Medium lz‘
Day/Might Switchingls) 3
 On @ O WDR off [=]
1712 WDR Level -
0 Suppress WDR Stripes i@ Off = On

Center-Weighted Average Metering El

2. Set the parameters as required. The following table describes some major parameters.

Parameter Description
E . .
M)(()p()jc;sure Select the correct exposure mode to achieve the desired exposure effect.
Shutter is used to control the light that comes irh® lens. A fast shutter speed is ideal f
Shutter (s) scenes in quick motion. A slow shutter speed is ideal for scenes that change slowly.

Note:

17



Parameter

Description

You can set a shutter speed whErposure Modeas set toManual or Shutter Priority.

If Slow Shutteris set toOff, thereciprocal of the shutter speed must be greater than t
frame rate

Gain (dB)

Control image signals gbat the camera outputs standard video signals according to
light condition.

Note:
You can set this parameter only whErposure Modeés set toManual or Gain Priority

Slow Shutter

Improves image brightness in Idight conditions

Note:

You can set this parameter only wh&xposure Modes not set toShutter Priority and
whenImage Stabilizeis disabled.

Slowest
Shutter

Set the slowest shuttespeed that the camera can use during exposure.

Note:
You can set this parameter only wh8tow Shutteris set toOn.

Compensation

Adjust the compensation value as required to achieve the desired effects.

Note:
You can set this parameter only whErposure Modeés not set toManual.

Metering
Control

Set the way the camera measures the intensity of light.
CenterWeighted Average Metering: Measure light mainly in the central part of imag
Evaluative Metering: Measure light in the customized areanages.

Highlight compensation: Ignore the brightness of the overexposed area of image:
selecting this setting will decrease the overall brightness of the image.

Note:
You can set this parameter only whERposure Modeés not set toManual.

Day/Nght
Mode

Automatic: The camera outputs the optimum images according to the light conditic
this mode, the camera can switch between night mode and day mode automatically

Night: The camera provides higjuality black and white images using the existiggt
Day: The camera provides highality color images using the existing light.

Day/Night
Sersitivity

Light threshold for switching between day mode and night mode. A higher sensitivity n
that the camera is more sensitive to the change of ligihdl becomes more easily to switc
between day mode and night mode.

Note:

You can set this parameter only whBay/Night Modeis set toAutomatic.

Day/Night
Switching(s)

Set thelength of time before the camera switches between day mode and night mode
the conditions for switching are met.

Note:
You can set this parameter only whBay/Night Modeis set toAutomatic.

Enable WDR to distinguish the bright and dark areéisdrsameimage.
Note:

WDR
You can set this parameter only whErposure Modés neither Customizenor Manual and
whenlImage Stabilizeis disabled
After enabling the WDR function, you can improve the image by adjusting the WDR le'
WDR Level | Note:

Use level 7 or higher when there is a high contrast between the bright and daak af¢he
scene. In the case of low contrast, it is recommended to disable WDR or use-@evel 1

18



Parameter Description

uppress WDF When enabled, the camera can automaticadigjust slow shuttefrequencyaccording to
Stripes the frequency of light taninimiz stripes thatmayappear in images.

3. To restore the default settings, cli@efault
Smart lllumination

@ NOTE!

This function may vary with modelBleasesee actual Web interface for details.

1. ClickSetup>Image>Imageand then clicksmart lllumination

T Smart Hlumination

Smart Hlumination @ COn ) Off

Lighting Type [ Infrared v
Control Mode [ Manual v
Mear-illumination Level D |
Far-illumination Level [ |

2. Select thecorrect IR control mode and set the parameters. The following table describes some major
parameters.

Parameter Description

Global Mode: The camera djusts IR illumination and exposure to achieve balance
image effecs. Some areas might beverexposed if gu select this optionThisoption is
recommended if monitored range and image brightnass your first priority
Overexposure Restrain The camera djusts IR illumination and exposure toavoid
regionaloverexposureSome areas might be dark if you select this option. Dipigon is
recommended ifclarity of the central part of the imagand overexposure control are
Control Mode your first priority.

Road This modeoffers strong illumination in whole arid recommendedor monitoring
wide-rangng scenesfor exampleroad.

Park This modeoffers uniform light ands recommendedor monitoring small range
scenes withmanyobstacles, for exampléndustrial paris.

Manual: This mode allows you to manually control the intensity of i(Rnilhation.
Indoor: This mode is recommended for application in indoor scenes.

Set the intensity level of the IR light. The greater the value, the higher the intens
means that the IR light is turned off.

Note:
[llumination . You can set this parameter only wh€entrol Modeis set toManual.
Level . You areecommendedo set this parameter first for a widangle scene.
You are recommended to set this parameter first if the scene requires an interme
focal length.

You are recommaetted to set this parameter first if the scene requires a telephoto vie'

3. To restore the default settings, cli€lefault.
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Focus

@ NOTE!

This function may vary with naiels Pleasesee actual modelfor details.

1. ClickSetup>Image>Imageand then click-ocus

¥ Focus
Focus Mode |One-C|El{ Focus V|
Scene |N|::rma v|

2. Select the focus mode as required.

Parameter Description

Auto Focus: The camefacusesautomatically according to the current light condition.
Manual Focus: Manually adjust camera focus as required.

Focus Mode | - f())n:;:rllecsl;FIocusThe camera is triggered to focus once when rotating, zooming or ¢

OneClickFocus(IR): In a low light condition such as during night hours or in a
house, this focus mode achieves better effects with the IR light turned on.
Nomal: Used forcommonscenes, such asad andindustrial park.

Scene . Long Distancetsed forlongdistancemonitoring on aroad. For example,when the
cameraisinstalledover 30 metershighto monitor a distant road intersection

3. To restore the default settings, cli@efault.
White Balance

White balance is the process of offsetting unnatural color cast in images under different color temperatures
SO as to output images that best suit human eyes.

@ NOTE!

This function may vary witmodels Pleasesee the actual Web interface for details.

1. ClickSetup>Image>Imageand then clickVhite Balance

¥ White Balance

White Balance Auto |Z|
Red Offset =
Blue Offset =

2. Select a white balance mode as required. The following table describes some major parameters.

Parameter Description

Adjust the red or blue offset of the image:

Auto/Auto2: The camera adjusts the red and blue offset automatically according tc
light condition (the color tends to be bludj.the images are still unnaturallyred or blue
in Auto mode please try Auto2

Fne Tune: Allow you to adjust the red and blue offset manually.

White Balance|
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Outdoor: Suitable for outdoor environment with relatively greag¢r color temperature
range.

Lockedlock the current color temperatusgithout change

Sodium LampThe camera adjusts red atfdue offset automatically according to th
light condition (the color tends to be red).

Adjust the red offset manually.
Red Offset Note:

You can set this parameter only whé&White Balancds set toFine Tune

Adjust the blue offset manually.
Blue Offset Note:

You can set this parameter only whérfhite Balances set toFine Tune

3. To restore the default settings, cli@efault

Advanced
Use the defog function to adjust the clarity of images captured in fog or haze conditions.
1. ClickSetup>Image>Imageand then clickAdvanced

T Advai
Defog Off |z| Image Stable DI |z|
Defog Intensity e — (5

@ NOTE!

You can set this parameter only when WDR is turned off.

Only some camera models support optical defé¢hen Defogis set to On, defog intensity ével 69
representoptical defog andimages change from color to black/white when defog intensisysetfrom
level 5 to 6;if Defogis set toAuto and defogintensity level is somewhere betweer6-9, images do ne
automaticallychange to black/white itight fog conditions the camera automaticallgwitches to optice
defog onlyin heavy fog conditions

2. Enable the defog function and then select a level for the scene. BeaaHlieves the maximum defog
effects, and level 1 achieves the minimum.

Defog Off Defog On

3. To restore the default settings, cli€efault
Lighting Type

@ NOTE!

This function may vary with modeBleasesee the actual model for details.
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1. ClickSetup>Image>Imageand then clicksmart lllumination

iy T Infrared (=]

2. Select an option from theighting Typedrop-down list.
3. To restore the default settings, cli@efault
Configuring Iris and LenMode

@ NOTE!

This function is only supported by certain netwdrx camera types Pleasesee the actual model fi
details.

Please use the lens withIRs controlmode, and connect the iris control cable to the Z/F port of
camera.

Iris can be set only whdrens Modes set toP-IRIS

1. ClickSetup>Image>Imageand thenclickAdvanced

7 Advanced

Defog off [=]  LensMode P-IRIS [=]

Defog Intensity - Aperture Control Manual |z|

F-MNumber ;100

Use Recommended Value

2. Modify the settings as required. The following table describes some npajameters.

Parameter Description
Z/F: to modify focus and zoom.
Lens Mode . fy -
P-Iris: to modify iris value.
Automatically or manually adjust iris.
Aperture )
Note:
Control ) ) ]
You can set this parameter only wheans Modds set toP-Iris.
FNumber Changeaperturemanually.

3. To restore the default settings, cli@efault

OSDSetting

On Screen Display (OSD) is the text displayed on the screen with video images and may include time an
other customized contents.

@ NOTE!

This function may vary with modeBleasesee the actual Web interface for details.

1. ClickSetup>Image>OSD
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Live View

areal Enable  No. Overlav OSD Content X-Axis  V-Axis

— _

(@ 1 <Date & Times v ’
SR B
S
oo O
o s R
0o s o]
ooz O
o s O | C
Display Style
Erect
Fort iz

v . Fort Color o
e — Min. Margi

Date Format dd/MMiyyyy v dd=Day; dddd=Day of the week; M=Month; y=Year
Time Format h/H=12/24 Hour; tt=A.M. or P.M.; mm=Minute; ss=Second

‘Orientation

Direction | Please selec v Crient

The OSD interface of sonmeodels is displayed as follows.

Live View

| Enable Mo Owerlav 050 Content H-Aois  W-Huis

areal

=
@ 1 <Date & Times v i)
o 2 75 3
o s
o ¢ ]
o s [
1 o s ]
e I [ -
[None] vimem T B R I
v A < o Display Style
ST RAHEEE EErTR—
-
« 1 » o e _ :
N Font Sce
v Font Color #0000-1 @
= - Date Format dd/MMiyyyy ~]  dd=Day; dddd=Day of the week; M=Month; y=Year
| % | G
Time Farmat hfH=12/24 Hour; tt=AM. or P.M; mm=Minute; ss=Second

Orientation

Direction | Please selec v Orient

2. Select the position and content of the OSD.

Position: Click the desired box in theve Viewarea. After the cursor shape is changed, click and hold
the button to move the box to the desired position. To set the position precisely, use the X and Y
coordinates undeOverlay Area

Overlay OSD Content: The drdpwn list providesTime, Presetand Serial Info You may also select
Customand enter the content you want.

After you have set the position and OSD content, #fesymbol appears in th&tatuscolumn, which
means that the OSD is set successfully. You may set multiple lines of contentdhfaremeand use~.
and ~~ to adjust the sequence of display.

3. After you have completed the settings, a message appears to indicate the successful settings.

You may rightlick in the previewwindow and then choose to view in full screen mode or at an aspect
ratio. You may also doublgick the previewvindowto enter or exit full screen mode.

To cancel OSD for an area, clear the OSD content i@vkday OSD Contemlumn or selecNonein the
Positioncolumn.

The following shows an example time OSD.
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Privay Mask

On certain occasions, you may need to set a mask area on the camera image to protect privacy, for
example, the keyboard of an ATM machine. When PTZ changes its position or zooms, the Privacy Mask wi
be adjusted accordingly to protect the areaalthng.

@ NOTE!

This function may vary with modelBleasesee the actual Web interface for details.

1. ClickSetup>Image> Privecy Mask

Privacy Mask

| Add || Delete
Mao. Marme Max. Zoom Operation

1 Maskl

For some camera modelthe page is displayed as follows:
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Privacy Mask

Add Delete

,’,IT

L
[More)  v|m o @
A
v Y all®| =
<« 1 » oo
I S 4
v

2. Clickt to add a privacy mask, and clil to delete a mask.
To mask a position: Click the box (whttask displayed on it) to activate the mask. After the cursor
shape has changed, drag the box to the intended position.

., To mask an area: Use the mouse to draw a box on the area you want to mask.

When privacy mask is configured, the intended area is blocked. The following shows an example.

Audio and Video Configuration

Video Configuration

You can set video parameters that your camera supports and view the current status of BNC output. If
availableyou may also enable stgiream and third stream as required.

2 NOTE!
This function may vary with models. Only some camera models support the third stream. To dete
your camera supports this function, see the Web interface.
After enabling the sub othird stream, modify the parameters as required. The parameters for thi
and third stream have the same meanings as that for the main stream.

1. ClickSetup>Video & Audio>Video.
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Capture Mode

Main Stream

Video Compression
Reszclution

Frame Ratelfps)

Bit Rate(Kbps)

Bitrate Type

Image Quality

I Frame Interval

GOF

Smoothing

SVIC

U-Code

ENC Output

Mode

1020P@25 =

H.264 =
1080P
25 =
4096 [128~16384]
CBR =
Quality Bit Rate
=E‘_
50 [5 ~ 250]
P
Clear Smooth
_\_—
On @y OF
off =
PAL =

2. Modify the settings as required. The following table describes smaer parameters.

Parameter Description
Three optionsH.265, H.264nd MJPEG
Note:
Video Image Quality cannot be saethen Video Compression is set to H.265 or H.264. W

Compression

set to MJPEQnly three frame rates are availablgé; 3 and 5; andBit Rate, | Frame
Interval, Smoothing and-Qode cannot be set.

The bit rate changes to the default when you chatige setting betweerH.264and
H.265.The default bit rate for H.265 is half of that for H.264.

Frame Rate

Frame rate for encoding imagesniti FPS (frame per second).

Note:

To ensure image quality, note that the frame rate should not be greater than
reciprocal of shutter speed.

Bitrate Type

CBR: Constant Bit Rate, which means that the camera transmits data at a ca
data rate.

VBRVariable Bit Rate, which means that the camera adjusts the bit rate dynam
according to image quality.

Image Quality

WhenEncoding Modes VBR you can move the slider to adjust quality level for imac
Moving the slider towardit Ratedecreases th bit rate and may affect image qualit
Moving the slider towardQuality increases the bit rate and improves image quality.

| Frame Interval

Interval at which ar frame is encodedNormally, ashorter | frame intervabffers better
image qualitybut consumesnore bandwidth.

GOP

Group Of Acturesin MPEG video encodin@his parametespecifies the order in whicl
intra-frames(l frame)and interframes are arranged.
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Parameter Description
SvC SVC (Scalable Video Coding) can redtarage withoutcompromisingplaybackguality.
Basic Mode: Thactualbit rate isaround3/4 of the set bit rate.
Advanced Mode: Thactualbit rate isaround1/2 of the set bit rate
Note:
U-Code WhenU-Codeis enablegdvideo compression only supports H.264 and H.265. MJP!
not supported.
When UCode is enabledhe capture mode does natupportframe rates higher than
30.
Set the extent of smoothing. Choosi@lear means disablingsmoothing Moving the
i slider towardSmoothincreases the level of smoothing but will affect imagelity.
Smoothing
Note:
In a poor network environment, you can enable smoothing to get more fluent video.
BNC Output BNC output supports NTSC and PAL.
3. ClickSave

Audio Configuration

Audio configuration means setting audio encoding parameters for your camera.

@ NOTE!

This function is not supported by some modélease see the actual model for details.

1. ClickSetup>Video & Audio>Audio.

Audic Input
Audio Input
Access Mode

Input Gain

Audio Compression
Sampling Rate(KHz)

Moise Suppression

Channel 1

On g Off
Line/Mic [w]
128 [0~255]
GT11U =
g
On i@ Off
Line =] @ Enable

2. Modify the settings as required. The following table describes some major parameters.

Parameter

Description

Audio Input

No audio data will be encoded whéff is selected.

Note:

It is recommended to seledDff if you do not need audio. This can improve dev
performance to some extent.

Access Mode

Currently only LingMic.
Note:
This function is not available to deviogih two audio output channels

Audio

Three optionsG.711YG.711Aand ACE.C.
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Parameter Description

Compression | G.711Uand G.711Asupport 8K sampling ratenly, and ACGLC supports 8K, 16K and 4
sampling rates.

Input Gain Audio signal amplification for sampling. Theajes the gain, the greater amplification.

Noise

. Used to reduce noise in images. To enable noise suppression, Galect
Suppression

Audio output channelTo enable audio output, seleEnable
Channel Note:

Only somecamera models support two channels

3. ClickSave
STapshot
1. ClickSetup>Video & Audio>Snapshot
Snapshot On g OF
Resolution 1920*1080 =
Image Quality Medium =
Scheduled Snapshat
Snapshot Interval 1
Mumber to Snapshot 1 =
Snapshot Mode Schedule @ Repeat
Interval(s) €0

2. SelectOn, and then set resolution, image quality and schedadaeeded
3. ClickSave

ROI

When Region of Interest (ROI) is enabled, the system ensures image quality for ROI first ifdate ibit
insufficient.

@ NOTE!

This function is not supported by some modélease see the actual model for details.

1. ClickSetup>Video & Audio>ROlI
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2. Click®, and then drag thenouseto coverthe intendedpart of the imagesTo deleteselect the area

and thenclick I .

Media Stream Configuration

Media Stream

You can display the established media streams from a camera. You may also set the camera so it transmit
code streams by the UDP or TCP protocol to a specified IP address amdipbetr. The settings can be
saved and take effect after the camera is restarted.

= NOTE!
This function is not supported by some modélease see the actual model for details.

Choosing a transport protocol based on your actual needs and network perfoer@anerally speakin
TCRenablesbetter image qualitthan UDFbut alsocausedhigher latency

1. ClickSetup>Video & Audio>Media Stream

Stream Profile IP Address Port Protocol Persistent +
Add Media Stream
Stream Profile Wain Stream |Z|
IP Address
Port
Protocol TSIUDP [=]
Persistent " Enable @ Disable
oK Cancel

2. Click +, select a stream type, and then set the IP address and port number of the unicast or multicast

groupfor the decoding device that receives audio and video streams from the camera.

If you want the device t@stablish the media strearthat has been configuredbefore automaticaly
after the restart, selecYesfor Persistent
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3. To delete a stream, clicTl.
4. ClickSubmitto complete the operations.
RTSP Multicast Address
After an RTSP multicaatidressis configuredthe third-party player can request the RTSP multicast media
stream fromthe camera througtthe RTP protocol.
1. ClickSetup>Video & Audio>Media Stream>RTSP Multicast Address

rMain Stream
Multicast Address 0.0.0.0
Port ]
rSulb Stream
Multicast Address 0.0.0.0
Port ]
"~ Third Stream
Multicast Address 0.0.0.0
Port ]
| Save

For some camera models, the page is displayed as follows.

~Main Stream
Multicast Address (0.0.0.0 |
Port [ |
~Sub Stream
Multicast Address (0.0.0.0 |
Port [ |
~Third Stream
Multicast Address [0.0.0.0 |
Port [ |
Multicast Address (0.0.0.0 |
Port [ |
Multicast Address (0.0.0.0 |
Port [ |
Multicast Address [0.0.0.0 |
Port [ |

2. Setthe multicast addresg24.0.0.0to 239.255.255.25pand port number0to 65535)
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3. ClickSave

Intelligent AlarmConfiguration

You can configurdntelligent monitoring to count people and monitor moving objectdntelligent
monitoring includes people counting, intrusion detectiamdauto tracking.

Thesupportedfunctions may vary witikamera model

Smart Settings

ClickSetup> Intelligent > SmartSettings

Cross Line o m Intrusicn o

Face

& 2 Face o
People Counting

[l People Counting £
Auto Tracking

[ |y AutoTracking O

For some camera models, the page is displayed as follows.

] Cross Line e ] Intrusion £

Exception Detection & Statistics

kA @ Defocus O b BFRY Scene Change O
Face

] Face £

People Counting

O] People Counting o

Cross Line Dection

Cross line detection detects objects that crasdrtual linein live videoand triggers alarnwhen suchan
event is detected.

1. ClickSetup> Intelligent > SmartSettings ChooseCross Linand then clicl,"‘:"r :
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V] Cross Line Detection Detection Rule =+ | Rulel

| E—
./.

Sensitivity Bo ]
- _‘ ) ‘2 || [Trigger Actions
# & fi | OJAlam Output [] Upload to FTP [] Trigger E-mail [] Trigger Tracking
A

- LalallElZ N e
(< 1)) —_ | 9 Amed| | [ unamed| | Eat |

(&= EX

S0 4 (% 01234567809 1011121314151617183192021222324

Mon

'—I_Q

Tue
Wed
Thu
Fri
Sat

Sun

2. SelectCross Line Detection

3. In theDetection Rulearea, click™ to add anew detection areaTo delete a detection area, clici .

4. On the small preview window radgthe lineto the intended position and seht detection range

5. Setthe direction and sensitivitfor the camera to decide whether to report @oss linedetection
alarm

6. Set the alarmrriggered actions and arming schedule as required. For the detailed steps, see the
descriptions of alarrtriggeredactions inConfiguring Motion Detection Alarm

7. ClickSave

IntrusionDetection

Intrusion detection detects objects that enter a specified area invigeo and triggers alarm when such an
event is detected.

1. ClickSetup> Intelligent > Smart SettingsChoosdntrusion and then clic o .
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] Intrusion Detection Detection Rule -+ Rulel

Time Threshold(s)
Sensitivity —_— ——
Percentage &
. ‘ Trigger Actions
» @ i [[] Alarm Output [] Upload to FTP [[] Trigger E-mail [[] Trigger Tracking
A
vy < T
Q Q 2 == [|Enable Plan
< " > ] Armed | | [ | Unarmed Edit
F i x
v

% 0123456780 101112131415161718192021222324
Mon | ] ‘ }

Tue ‘ [ |
Wed ‘ |

B 17 0
Fri | |

! { {
sat | \
| | |

Sun ‘

2. Selectintrusion Detection.

3. In theDetection Rulearea, click¥ to add a new detection area. To delete a detection area, (k

4. Dragthe borders of the box to set the intended position and range.

5. Set time threshold, sensitivity, and percentagm the camera to decide whether to reportna
intrusiondetection alarm

Time Threshold: The minimum length of time that the intruder stays in the detection area before an
alarm will be reported.

Sensitivity:Sensitivity of detectionA greater value meartigherdetectionsensitivity

PercentageThe minimunratio of the intruder's sizeto the size of thespecified detection arehefore
an alarm will be reported.

6. Set the alarmrtriggered actions and arming schedule as required. For the detailed steps, see the
descriptions of alarrtriggered actions il€onfiguring Motion Detection Alarm

7. ClickSave

FaceDetection

Face detection detects human faces in live video.

1. ClickSetup> Intelligent > Smart SettingsChoosd-aceandthen click o .
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Smart Settings > Face

E
Face

Detection Area O Full Screen @ Specified Area
Detection Sensitivity e —
Snapshot Mode [« Intelligent Recognition [_] Alarm Input
Number of Snapshots
Counting (O On (e Off
~Filter by Object Size (Width) (%)
Max. Size
Min. Size
Trigger Acti
Upload Image [[] Alarm Output

[[] Thumbnail Image

-[JEnable Plan
(I Armed] | [] Unarmed] | Edt

01234567809 101112131415161718192021222324
Mon

Tue
Wed
Thu
Fri

Drag the borders to set the intended position and range.

Set detection parameters according to actual needs.

ClickStart Intelligent Analysis

Set the alarmiriggered actions and arming schedule as required. For the detailed steps, see the
descriptions of alarmtriggered actions ilf€onfiguring Motion Detection Alarm

6. ClickSave

A S

Peopke Caunting

¥ NOTE!
Only some camera models supptts function

Thesupportedalarm triggeing and armingschedule may vary with camera modBleasesee theactua
Web interfacefor details

1. ClickSetup>Intelligent > Smart SettingsChoosePeople Countingnd then cIicI,a .
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W] Enable Passenger Flow Detection

/V‘ Detection Mode Indoor v

// [l Reset Counterat  00:00:00

Sensitivity e —
Draw Detection Area

Draw Entrance Direction

Filter by Object Size (Width X Height)(px)

Max. Size [220 | X[220 |
Min. Size [120 | x[120 |
[JEnable Plan
A [ Armed|| [ ] Unarmed Edit
\ 4 v
01 2345678010111213141‘161718192021222324
<« n» vor. TG TG
2 4 Tue [ ' [ [
v R 11 15 S I (1 U 11 I ) L (B U1 5] ) Lo ) ) PO
Wed
- e — Thu [
e R SR USE i LS ‘ ...........
T N ——T = Sat
Tip: Please set the detection area between the two red Ilnes TSN ARl |11 11 E [ 1 00 R IR W0 O |
achieve the best detection effect. Sun

Clear Counting Result

2. SelectEnable Passengéilow Detection Slect a detection mode, seeport interval and sensitivity.
ClickDraw Detection Areaand then drawa detection area orthe preview window on the lefte.g., a
square

4. ClickDraw Entrance Directionand then draw the direction on the prew window on the leftThe
direction is usually vertical or sloping

5. SetMax. Sizeand Min. Sizeunder Filter by Object SizeOnly objectswithin the size rangewill be
counted;otherswill be filtered and notounted

6. Set the alarrtriggered actions andarming schedule as required. For the detailed steps, see the
descriptions of alarrtriggered actions irf€onfiguring Motion Detection Alarm

To reset ounting results, clickClear Counting Result
ClickSave

Auto Tracking

The camera automatically tracks an object that triggers the rule.

= NOTE!
Only some camera models supptints function

The supported alarm triggering and arming schedule may withy camera modelPleasesee theactua
Web interfacefor details

1. ClickSetup> Intelligent > Smart SettingsChooseAuto Trackingand then clicl,"‘:"r .
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Enable Auto Tracking

Parameters
Tracking Timeout(s) 30
Zoom Auto |z|

2. Set tracking timeout (unit: sec) and zoom ratio.
3. ClickSave

Defoaus Detection

@ NOTE!

Only some camera models supptits function

The supported alarm triggering and arming schedule may vary with camera ribeletesee theactua
Web interfacefor details

Use defocus detection tdetect defocus of the camera and to report an alawhen such an event is
detected

1. ClickSetup> Intelligent > Smart SettingsChooseDefocusand then clicl o .

k] Defocus Detection
Sensitivity _P
2. SelectDefocus Detection

3. Set detection sensitivity andalarm+triggered actions as required. For the detailed steps, see the
descriptions oflarm-triggered actions il€onfiguring Motion Detection Alarm
4. ClickSave
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Scene Changeetection

= NOTE!
Only some camera models support this function

The supported alarm triggering and arming schedule may vary with camera model. fdeatheactua
Web interfacefor details

Use scene change detection detect the change of surveillance environment caused by external factors
such as intentional rotation of the camera, and to report an alarm when such an event is detected.

1. ClickSetup> Intelligent > Smart SettingsChooseScene Changand then clict o .

Scene Change Detection

SE-nsiﬁyi‘[}r O
—Trigger Actions

[JUpload to FTP

[] Trigger E-mail

_|Enable Plan

| [ Armed|| [] Unarmed|  Edit |

0123456780 101M121314151617181020212223 24

Mon
Tue
Wed
Thu
Fri

Sun

2. SelectScene Change Detection

3. Set detection sensitivitySet the alarrdriggered actions and arming schedule as required. For the
detailed steps, see the descriptions of alamiggeredactions inConfiguring Motion Detection Alarm

4. ClickSave

Advanced Settings

Advanced settings include snapshot clarity and detection mode forigeati functions.
Photo parameters

Set clarity of snapshots.

1. ClickSetup> Intelligent >Advanced Settinggdick Photo parameterstab.

Iﬂﬁt'r

Single Photo o —

2. Set snapshot clarity.
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3. ClickSave
Detection Parameters

2 NOTE!
Only some camera models suppardvanced settingdleasesee theactualWeb interfacefor details
The defauldetectionmode isNormal Mode Set as required.

1. ClickSetup> Intelligent > Advanced Settingdick Detectionparameterstab.

Dietection Mode Normal Mode
ﬁ Filter Repeated Motion Mode

2. Choose a detection mod€hooserilter Repeated Motion Modédo prevent repeated alarm reporting
caused by repeated motiodetectedin the surveillance environment.

3. ClickSave

CommonAlarm Configuration

You can schedule alarm reporting and set actions that can be triggered by other devices so that alarms anc
the triggered actions can be handled in time.

Alarm reporting can be scheduled for motion detection alarm, alarm input, alarm output, tampering
detection alarm, and audio detection alarm. The supported alarms may vary with device model. For the
alarm types thayour camera supports, see the Web interface.

Configuring Motion Detection Alarm

Motion detectiondetects theobject motion in a specifietectangulararea during a periodvou need toset
a detection area, sensitivity of detection, object size, dnstory for the camerato decide whether to
report a motion detection alarrwhen it detects motion

= NOTE!
This function is not supported by some modélgase see the actual model for details.
The alarm triggered actions may vary with modé&lsase seg¢he actual Web interface for details.

Area Detection
1. ClickSetup>Events> Common Alarn® Motion Detection. SetDetection Modeto Area
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Detection Mode [Area

Detection Area -+ Areal

Object Size Small o —— | arge

Duration Short | ee—— LONg

TN [T TR NN

Alarm Parameters

Suppress Alarm(s)
Clear Alarm(s)
Trigger Actions
[[J Alarm Output 1 [] Goto Preset | 1[DOOR] v [JUpload to FTP [[] Recording
[] Trigger E-mail
{ViEnable Plan
[ Armed|| [] Unarmed Edit

0123456789 101112131415161718192021222324

In the Detection Areaarea click + to add a new detection area. To delete a detection area, (I sk

Click andirag the mouse to set a detection area.
Set the detection sensitivity, object size, and history for the camera to decide whether to report a
motion detection alarm.

Moving the slider to the right increases detection sensitivity. When the extent of motitmnthe
detection area exceeds the set object size, and if the duration of motion exceeds the set duration, the
camera reports an alarm.

Object size specifies the minimum ratio of the object's size to the size ofothkdetection area
before an alarmwill be reported That is to say, to detechotion oftiny objects,you need todraw a
smallbox (detection arealn the actualmotion areaaccordingly

Motion detection results are shown in real time. The red lines represent the raised motion detection
alarms. The longer a line, the greater the extent of motion. The denser the lines, the greater the
frequency of motion.

St the alarm parameters.
Quppress Alarr(s) After an alarm igriggered the same alarm will not be reported within the sine.
Clear Alarr(s} After an alarm igriggered

a. If the same alarm isot triggeredwithin the set time the alarm will be clearednd the same
alarmcanbe reported again.

b. If the same alarm is triggerealithin the set time the alarmwill not be cleared untithe suppress
alarmtime expires Then the same alarmanbe reported again.

Set actions to be triggered by motion detection alarm and the plan.
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The following table describes the major alatmygered actions and how to set a plan.

Item Description

Select the check box. This setting is the alarm output interface linked to motion detection &
Alarm Note:
Output 1 When an alarm is reported, the camera triggers alarm output so as to trigger actions

third-party device.

Select the checkox and set the preset linked to motion detection alarm.

Note:
Goto Make sure you have set presets. Otherwise, you cannot set this parameter. For details
Preset how to set a preset, seBetting Presets

When an alarm is reported, the PTZ camera automatically goes to the preset to capture
in the correct scene.

With Upload to FTRselected, the camera will automatically upload snapshotthto specified
Upload to| FTP server when an alarm is triggered.
FTP Note:

Make sure you have completédl Pand Snapshobefore using this function.

With Recordingselected, the camera will automatically record video when an alarm is trigge
Recording Note:

Please sePostRecord(spn the Storagepagefirst. PostRecords) specifies how long recordin

continuesafter the end ofanalarm.

With Alarm the Centerselected, thecamerawill sends alarm information to the central serv
Alarm the| When an alarm is triggered.
Center Note:

Please complete settings on tiserverpagefirst.

With Trigger Trackingelectedthe camera starts auto tracking when an alarm is triggered.
Trigger Note:
Tracking Only some camera models support this function.

Please set auto tracking on tismart Settingpagefirst.

With Trigger Email selected, the camera will automatically send snapshots to the spec
Trigger E-mail address when an alarm is triggered.
Email Note:

Make sure you have completdeMail and ! L [ before using this function.

Select the check box and set the start and end times during which motion detection ale

effective You can directly drag the mouse to draw a péand clickEdit to edit time periods in
Enable Plar the table The time periods cannot overlafthe camera reports alarms during the specifi

period(s) only.
You can select from Monday to Sunday and set four periods for each day.
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[vEnable Plan Edit
Armed Unarmed Edit Men Tue Wed Thu Fri Sat sun
01234567809 101M112131415161718192021222324 Nao. Start Time End Time
Mon 1 00:00:00 23:50:59
Tue 2
Wed 3
Thu .
Fri
Sat CopyTo  []Select all
Sun ~Mon  []Tue [Jwed [JThu [JFri []sat [JSun
Copy
OK Cancel
Dragthe mouse to drawa plan Edit time periods in the table
Note:
Plan drawingising a mouse is only supportegt IE versions later than 8 After setting the plan
for one day, you can apply the same settings to other days by cliCkipgand Paste

7. ClickSave
Grid Detection
1. ClickSetup>Events>Motion Detection. SetDetection Modeto Grid.

Detection Mode |Gﬂd v| Sensitivity Low _» High
r
‘4 é Alarm Parameters
4 V‘ I 15
T | Suppress Alarmis) IR
full L/ '
—— alr ™ | clear Alammis)
S )
n S /‘ X Trigger Actions
oo \—:L 5 : [] Alarm Qutput 1 [ Goto Preset 1[DOOR] W [ upload to FTP [] Recording
S el 1 =
[— . H = ] | — ﬁ [] Trigger E-mail
N T
¥ [ [ il
[ o |3 " p—— 14 Y 1T B ] [ v ‘ . J [Enable Plan
~ 2 Armed Unarmed Edit
P
A < D1234567 89 101112131415161718192021222324
v @ all ¥ | = Mon
« 11 » Tue
» 4 * Wed
A\ ) Thy
— Fri

2. Detection area(s) can be irregular on the grid.

Set detection sensitivitfor the camera to decide whether to repoat motion detection alarm (alarm
visible on compatible NVR).

4. Set alam parameters.
Quppress Alarm(s): After an alarmtiigggered the same alarm will not be reported within the set time.
Clear Alarm(s): After an alarmtigygered

a. If the same alarm is not triggered within the set time, the alarm will be cleared andaime
alarm can be reported again.
b. If the same alarm is triggered within the set time, the alarm will not be cleared until the suppress
alarm time expiresThen the same alarm can be reported again.
5. Set actions to be triggered by motion detection alarm dhe plan.For the detailed steps, see the
descriptions of alarstriggered actions ifrea Detectionn Configuring Motion Detection Alarm
6. ClickSave
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Configuring Tampering Alarm

Configure tampering alarm so that the camera reports a tampering alarm when the lens is blocked for a
certain length of time.

=/ NOTE!

This function is nasupported by some model§lease see the actual model for details.
The alarm triggered actions may vary with modélsase see the actual Web interface for detalils.

1. ClickSetup>Events>Common AlarntTampering Alarm

Tampering Alarm ® On ) Off
Sensitivity oEEm— E—
Durstionts
Trigger Actions
[] Alarm Qutput 1 [ Goto Preset | 1[DOOR] W []Upload to FTP [] Recording [] Trigger E-mail
{wEnable Plan
Armed Unarmed Edit
01234567809 101M1121314151617181920212223 24
Mon
Tue
Wed

Thu

2. SelectOnfor Tampering Alarm
Set detection sensitivity and duration for the camera to decide whether to report a tampering alarm.
Sensitivity is divided into three levels: hitgvel, midlevel and lowlevel. Compared with mitevel
sensitivity, the camera can detect blocking fromagtier location when sensitivity is set to high. The
camera reports an alarm when the lens is blocked for a specified length of time.

Tampering alarm is effective to the whole screen. To disable tampering alarm, clearhegering
Alarm check box.

4. Set acions to be triggered by tampering alarms and the plan. For the detailed steps, see the
descriptions of alarrtriggered actions il€onfiguring Motion Detection Alarm
5. ClickSave

Configuring Audio Detection Alarm

The camera can detect input audio signals for exceptions. When the rise or fall of volume exceeds the sel
limit, or when the input volume reaches the threshold, the camera reports an alarnrigygers the set
actions. Make sure that an audio input device is correctly connected to the camera and audio input is
turned on inConfiguring Alarm Input

=/ NOTE!
This function is not supported by some modélgase see the actual web interface for details.
The alarm triggered actions may vary with modélease see the actual Web interface for details.

1. ClickSetup>Events> Common AlarnmAudio Detection
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400 Audio Detection (® On O Off

Detection Type Sudden Ris w

Difference
Trigger Actions
[] Alarm Qutput 1 [] Goto Preset | 1[DOOR] ~ [Jupload to FTP
[] Recording [] Trigger E-miail
[ Enable Plan
2 7] Amed|| [ | Unarmed Edit

01234567809 1011121314151617181920212223 24

Mon

Tue

Stop

2. SelectEnablefor Audio Detection select a detection type and set the difference or threshold. To
disable audio detection, clear thenablecheck box.

The following table describes some major parameters.

Parameter Description

Sudden RiseAn alarm is reported when the rise of volume exceeds the difference.
Sudden FallsAn alarm is reported when the fall of volume exceeds the difference.

Sudden ChangeAn alarm is reported when the rise or fall of volume exceeds
difference.

Threshold: An alarm is reported when the volume exceeds a threshold.

Detection
Type

Threshold: After a volume is set as the threshold, an alarm is reported wher
threshold is exceeded.

Difference: the difference between two volumes. When the rise or délivolume
exceeds the difference, an alarm is reported.

Note:
The scale in the audio detection area is used to measure sound volume.

Audio detection results are shown in real time. The red part indicates the reported ¢
detection alarms.

400

Difference

Volume (2
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Parameter Description
201 E

Difference

3. Set thealarmtriggered actions and arming schedule as required. For the detailed steps, see the
descriptions of alarrtriggered actions irf€onfiguring Motion Detection Alarm

4. ClickSave

Configuring Alarm Input

The camera can receive alarm information from a tigedty device. To use this function, you need to
configure the following information for alarm inpditst: port, alarm name,alarmtype (normally open or
normally closed) and alarm reporting time.

@ NOTE!

This function is not supported by some modélgase see the actual model for details.
The alarm triggered actions may vary with modélease seehie actual Web interface for details.

1. ClickSetup>Events> Common Alarnm®> Alarm Input

Select Alarm [Alarm Input 1 v
Alarm Mame [ |
Alarm ID [ |
Alarm Type [N.O. v
Alarm Input @® On () Off
~Trigger Actions

[] Alarm Qutput 1 [] Geto Preset | {[DOOR] d [] Upload to FTP [] Recording [] Trigger E-mail
[_|Enable Plan

[ B Amed| | ] Unarmed - Edt |

0123456780 101112131415161718192021222324
Mon

Tue

2. Selectalarmand set thealarmname.
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3. SelectN.O. or N.C.according to the type of the thirgarty alarm input device. For example, if the
third-party alarm input device is normally open, you need to seéleQ. here, so that the camera can
receive alarm information from the thirdarty alarm input device.

4. Set a&tions to be triggered by an input alarm and the plan. For the detailed steps, see the descriptions
of alarmtriggered actions irf€onfiguring Motion Detection Alarm

5. ClickSave

Configuring Alarm Output

After alarm output is triggered by a motion detection alarm, Boolean alarm, the camera can output alarm
information to the thirdparty device if alarm output is set correctly to Normally Open or Norn@tged.
The alarm output duration is configurable.

@ NOTE!

This function is not supported by some modélgase see the actual model for details.

1. ClickSetup>Events> Common Alarm> Alarm Output

Select Alarm | Alarm Output 1 vl
Alarm MName [2 |
Default Status [N.O. v|
Deelayis) [30 |
_|Enable Plan
' [ Armed|| [ | Unarmed|  Edit |

012345675 0 1011213141516 17123192021222324
Mon

Tue
Wed
Thu
Fri

Sun

2. Select thealarmand set thealarmname.
Set the status tdN.O. (default setting) and set the alarm duration.

4. Set actions to be triggered by an input alarm and the plan. For the detailed steps, see the descriptions
of alarmtriggered actions it€onfiguring Motion Detection Alarm

5. ClickSave

@ CAUTION!

Strictly follow the sequence when powering on the devices to avoid damaging camera component

1. Check that thalarmtype is set toNormally Open(default setting), and that the camera and the al
output device are powered off.

2. After completing the connection, power on the camera first and then power on the alarm «
device.

45



Memory Card Storage

= NOTE!
This function is notupported by some models, and may vary with mod&isase see the actual model
details.
Edge storage is recommended when the camera operates in stlm# mode. When the camera

managed by the central management server, you need to stop edge stoyegmid affecting the cacl
post recording service.

Setting Edge Storage

Edge storage is used to save video data and snapshots to the memory card directly. Edge storage i
recommended when the camera is running in stadoine mode.

Manual storage
Thecamera records live video repeatedly if manual storage is enabled.
1. ClickSetup> Storage> Storage

Storage Medium [Memory Card v] Format| /] Enable

Total Capacity 7594 MB, Free Space 382 MB.
Allocate Capacity

Video(MB) 7594 | (The remaining capacity is used for image storage.)
Common Snapshot(MB) [0 | (The remaining capacity is used for smart snapshot storage.)
Smart Snapshot(MB) 0

Video Storage Info

Storage Policy (® Manual Storage O Planned Storage O Off

Stream |Main Stream V|

When Storage Full (@ Overwrite () Stop

Post-Record(s) [60 |

For some camera models, the page is displayed as follows.

Storage Medium [Memory Card v] Format| V] Enable
Total Capacity 7514 MB, Free Space 7514 MB.
Allocate Capacity
Video(MB) (7514 | (The remaining capacity is used for image storage.)

Common Snapshot(MB) 0

Video Storage Info

Storage Policy (® Manual Storage () Planned Storage () Off
Stream [Main Stream v

When Storage Full (@ Overwrite () Stop

Post-Record(s) |60 |
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2. Start edge storage and modify the settings as requifBue following table describes sonmeajor

parameters.
Parameter Description
Storage resource type.
Note:
Storgge To format the memory card, disablthe storage function for the caréirst. Then Click
Medium Format and then clickOKto confirm the operation. The system will restart when t
format is completed.
Information about the total and free space is displayed.
Overwrite: If there is no free space in the memory card, new data will overwrite
Data o
. existing dita repeatedly.
Overwrite . . .
Policy Stop: If there is no free space in the memory card, new data will not be saved t
memory card.
PostRecords) For alarmtriggered recording,dngth of time that recording continues after the end of tl
alarm.
3. ClickSave

Plannedstorage

If planned storage is enablethe camera records video tihe memory card during the specified periods.
1. ClickSetup> Storage> Storage

Storage Medium [Memory Card v| |Format| ] Enable
Total Capacity 7594 MB, Free Space 382 MB.
~Allocate Capacity
Video(MB) (7594 | (The remaining capacity is used for image storage.)

Common Snapshot(MB) [0 | (The remaining capacity is used for smart snapshot storage.)

Smart Snapshot(MB) 0

~Video Storage Info
Storage Policy
Stream
When Storage Full
Post-Record(s)

(O Manual Storage (® Planned Storage O Off
[Main Stream v|

(® Overwrite () Stop

60 |

~Plan

9 Amed || [] Unarmed | Edit

012
Mon

Tue
Wed
Thu
Fri

3456789 1011121314151617181920212223 24
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For some camera models, the page is displayed as follows.

Storage Medium [Memory Card v| |Format| /] Enable
Total Capacity 7514 MB, Free Space 7514 MB.
~Allocate Capacity

Video(MB) (7514 | (The remaining capacity is used for image storage.)
Common Snapshot(MB) 0 ‘

~Video Storage Info
Storage Policy (O Manual Storage (@ Planned Storage () Off
Stream [Main Stream v|
When Storage Full (® Overwrite () Stop
Post-Record(s) (60 |
~Plan
[ Amed | [] Unarmed| | Edt

0123456789 101112131415161718192021222324
Mon

Tue
Wed
Thu
Fri
Sat

Sun

2. SelectPlamed Storage and then set theperiods during which the camera records video tohe
memory card.

3. ClickSave

@ NOTE!

Planned storage is not effective when manual storage and planned storage are both enabled.
To query recordings in the memory card, $8deo Playback and Download with Edge Storage

Setting Cache Post Recording

A camera under centralized management can use riemory card as a backup storage resource of the
central management servelf storage fromthe camerato the central storage devic& interrupteddue to
unstable network connection, the camera automaticaliyl start cache post recording and store videto

the memorycard.

With recording backup enabled, the cameran automaticallytransfer the videostored in the memory
card to astorageresource of the backup server in form of file when the communication between the
camera and the backup server is restored.
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= NOTE!
Before you set cache post recording for a camera, check that:
The memory card is correctly installed on the camera

Backup resource has been added on the central server.
Backup resource has been allocated for tagnera.

Disable edge storage
1. ClickSetup> Storage> Storage

Storage Medium |Memory Card v/| |Format| /] Enable
Total Capacity 7594 MB, Free Space 382 MB.
Allocate Capacity
Video(MB) |7594 ] (The remaining capacity is used for image storage.)
Common Snapshot(MB) [0 | (The remaining capacity is used for smart snapshot storage.)
Smart Snapshot(MB) 0
Video Storage Info
Storage Policy (O Manual Storage () Planned Storage (®) Off
Stream [Main Stream v|
When Storage Full (@ Overwrite () Stop
Post-Record(s) (60 ]

For some camera models, the page is displayed as follows.

Storage Medium |Memory Card v| |Format| /] Enable
Total Capacity 7514 MB, Free Space 7514 MB.
Allocate Capacity
Video(MB) [7514 J (The remaining capacity is used for image storage.)

Common Snapshot(MB) 0

Video Storage Info

Storage Policy (O Manual Storage () Planned Storage (e) Off
Stream [Main Stream M

When Storage Full (®) Overwrite () Stop

Post-Record(s) (60 |

2. SetEdgeStorageto Disable(which disables manual storage), and set video capacity.
3. ClickSave

System Maintenance

@ NOTE!

This function is not supported Bpme modelsHease see the actual model for details.
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Security

User Management

There are two types of users in the system:
Administrator: referred to asadmirg in this manual. The default name of the administrator is admin,
which cannot be modified. Admin has full permission and can manage all users and devices. Only one
admin user is allowed in the system.
Common user: referred to asisek in this manual. Useonly has permission to play live and recorded
video.Up to 32common users are allowed in the system.

You can addauser on the user management interfa@gender Setup> Security> User).

After the user is added successfulpu can change the password bgtering the new password or delete
the user by clearing the username.

= NOTE!
Only admin can change passwords. Changing the username or password for a user when the u
logged in will force the user to log out. The user must use theus@mame or password to log in.

Only admin camdd anddelete users. Deleting a user when the user is still logged in will force the 1
log out. A deleted user cannot log in.

Setting Secure Data Transmission
Set a secure channel for data transmissio ensure security.

@ NOTE!

This function is not supported by some modélease see the actual model for details.

1. ClickSetup>Network >Port.

HTTP Port 130 |
HTTPS Port 443 |
RTSP Port 554 |

2. Ente the port number in the HTTPS Rbtext box
Qick Save.
4. ClickSetup> Security>Network Security>HTTPS

HTTPS @ On 7, Off

550 Certificate Browse...

5. SelectOnfor HTTPSYou may impora custom SSL certificass needed.
6. dickSave

Next time you log in, enter the address imtps:/IP:HTTPS port numbeformat, for example,
https://192.168.0.13:4430 enter secure channel mod#.you usehe default HTTPS port, entbttps://IP.

RTSP Authentication

RTSP (Real Time Streaming Protocol) is an application layer prdottahsmit and controthe audioand
video, set RTSP authentication on the Web interface.

1. dick Setup> Security>Network Security> RTSP Authenticatian
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Authentication Digest (=]
Basic

Digest

2. Slectanauthentication mode (BasiciBest) and then clickave

Hide Vendor Information
You can seto hide thevendor information of the network camera on the Web interface.
1. dick Setup> Security> Registration Info

Hide Vendor Info i@ On ) Off

2. UnderRegistrationinfo, selectOn.
APR Binding

Thisfunction canprotect the camera from ARP attack&henthe camera visi an IP of another network
segmentvia a gateway it can communicate onlyith the MAC addresbinding to thegateway addres
the same segment

1. ClickSetup> Security>Network Security> ARPProtection

ARP Protection i@ On o Off
Gateway

Gateway MAC Address 0

2. Selectthe check box to enable the ARP bindingction andset thegatewayMAC address.
3. ClickSave

IP Address Filtering
Use IP address filtering to allow forbid access from specified IP address(es).

@ NOTE!

This function is not supported by some modélgase see the actual model for details.

1. ClickSetup> Security>Network Security>IP Address Filtering
IP Address Filtering @ On g Off

Filtering Mode Whitelist |Z|

Mo IF Address

Et |+

1 1.1.1.1

2. SelectOnto enable IP address filtering.
3. Select a filtering mode, and then add IP addfesks
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4. ClickSave

@ NOTE!

If Filtering Modeis set toWhitelist, then only the added IP address(es) are allowed to access the ¢
If Filtering Modeis set toBlacklist then only the added IP address(esg not allowed to access t
camera.

Up to 32 IP addresses are allow&gch IP address can be added once only.

The firstbyte of each IP address must be223, and the fourth cannot be 0. For example, the followir
addresses are illegal and cannotdmdded: 0.0.0.0, 127.0.0.1, 255.255.255.255, 224.0.0.1.

Access Palicy

@ NOTE!

Enabling friendly password does not affect usgoli turn it offand log in with a weak passwara pags
will pop up prompting you to change the passwoithere is ndCancebr Close buttoron this pageThe
default password is treated as weak.

1. ClickSetup> Security>Network Security> Access Policy

Telnet @ On = OfF

Friendly Password @ Enable ™ Off

2. SelectOnto enable Telnet, and seleEnableto enable friendly password.
3. ClickSave
Watermark
Use watermark to encrypt custom informatievith videoto preventunauthorized delete or alteratian

@ NOTE!

Only some camera models support this function.

1. ClickSetup> Security>Watermark

Watermark g On 7 Off

Watermark Content ABC

2. SelectOnto enable watermark, and then input watermark content.
3. ClickSave

Setting the System Time

You can use the following methods to adjust the system time of your device.
Manually Setting or Synchronizing the System Time
1. ClickSetup>Common>Time, and thenclick theTimetab.

Sync Mode Sync with Latest Server Time |E|
Time Zone (UTC) Lendon,Casablanca, Coordinated Universal Time |z|
System Time 2017-08-12 08:07:0% Sync with Computer Time
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2. Select a synchronization mode

Set the correct time zone and system time. You may also 8hgic with Computer Timedo
synchronize the time settings of your camera with that of your PC.
4. ClickSave

Synchronizing with the NTP Server
1. ClickSetup>Common>Time, and then click th&imetab.

Sync Mode | Sync with NTP Server v|
Time Zone |{LITC]| London,Casablanca, Coordinated Universal Time v
System Time 2017-09-13 074558 Sync with Computer Time

MNTP Server

MTP Server Address (0.0.0.0 |

Update Interval(s)
2. SetSync Modeto Sync with NTP Serveand then setthe IP address of the NTP senasrd update
interval.

3. ClickSave The camera will periodically synchronize time with the NTP server.
Setting theDST

1. ClickSetup>Common>Time, and then click th®STtab.

DST

DST @ On & OF

Start Time apr [=||First  [+][sun  [+]]02 (=] h
End Time Oct  [w| Last [=//5un [+] 02 (=] h
DST Bias 60mins (=]

2. SelectOn for DSTsetthe start time, end time, and DST bias.
3. ClickSave

Seting Servers

Intelligent Server
You need to configure the intelligent serveaif ultra sensitive cameiria managed by eentral server.
5 NOTE!

Only some camera models suppaonrtelligent server
To use face snapshot, you need to configure the TMS strwenichsnapshotsare uploaded.

1. ClickSetup>Common> Server and then click théntelligent Servertab.

TMS Server IP (0000 |
TMS Server Part

Platform Communication Type

LPRID [FC |
Camera Mo. [IPC |

2. Setthe IP address of the TMS server and complete other settings.
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3. ClickSave

Serial Port Mode Configuration

The RS485 serial port is ustdt data exchange with the thirdarty device. Serial port settings dhe
camera should be consistent withdt of the connected thirgbarty device.

@ NOTE!

This function is nosupported by some model$lease see the actual model for details.

PTZcontrol
To control a PTZ camera through a th@rty device, you need to séort Modeto PTZ Control

By sending?ELC@ compliant PTZ control commands throutite RS485 port, you can control the PTZ
camera without usinghe PTZ control panel.

1. ClickSetup> System> Ports & Devicesand then click th&erial Porttab.

RS485 1

Port Mode |PTZ Control V|
Baud Rate 9600 ~

Drata Bits 0 hd

Stop Bits 1 b

Parity Mone b

Flow Control MNone W

PTZ Protocol [INTERNAL-PTZ v

PTZ Mode Built-in PTZ Priority

Address Code 1

Enable Trans-Channel

2. SelectPTZ Controfrom the Port Mode drop-down list. The following table describes some major
parameters.

Parameter Description

Setthe PTZ protocol that the channel supports.

Note:
You can set this parameter only wheort Modeis set toPTZ Control
WhenPTZ Protocois set toINTERNAPTZ the camera can connect to the external P
without using the serial port (serial port parameters are grayed out). In this case

only need to connect the zoom and focus interfaces of the camethettens, and then
you can opegite the PTZ like an internal PTZ.

PTZ Protocol

Builtin PTZ Priority: When this option is selectdte camera firsttries to control the
PTZ(for example, to zoom or focudly itself instead of through the external PTZ. |
operatons that the camera cannaccomplish by itself, the camera uses the exter
PTZ Mode PTZ.
External PTZ PriorityThe camera first tries to control the PTZ through the |
connected through the serial port.
Note:
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Parameter Description

You can set this parameter only whenrt Modeis set toPTZ Control

When INTERNAYPTZis selected, this parameter is always setBoilt-in PTZ Priority
and it is unnecessary to connect the camera to an external PTZ through the seris
Control through the external PTZ is not effective even when the camera has
connectedto an external PTZ.

Set this parameter as required. Make sure PTZ control related interfaces are col
connected.

Setthe address code for the PTZ.

Address Code | NOt:
You can set this parameter only whBort Modeis set toPTZ Controhnd PTZ Protocois
not set toINTERNAPTZ

3. ClickSave
Transparentchannel

Use the RS485 serial port to achieve transparent data transmissiontheithird-party device Transparent
channel is mainly used to achieve transparent data transmission bettmaedevices.

= NOTE!
This function is not supported by some modélgase see the actual model for details.
Make sure thatou have sePort Modeto TransChannelfor your camera

1. ClickSetup> System> Ports & Devicesand then click th&erial Porttab.

RS435 1

Port Mode | Trans-Channel v|
Baud Rate | 9600 v |
Data Bits E vl
Stop Bits K v|
Parity | None v|
Flow Control | Mone vl

[+ Enakle Trans-Channel

Destination IP [1.1.1.1 |
Destination Port

Source IP 203.6.1.32

Source Port

2. SelectTransChannelfrom the Port Modedrop-down list.
SelectEnablefor TransChannel

4. Enter the destination IP address and port number (IP address and port humber that the transparent
channel connects to).

5. ClickSave
OSsD

To display informatiorfrom the third-party device on the OSD, you need to select OSD as the port mode.
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The camera receives information frotime third-party device through the RS485 serial port, translates the
received information, and then displays it tire OSD.

= NOTE!
Toenable the camera to correctly translate information received from the tpady device, make su

that the information sent by the thirgharty device through the serial port complies with the data for
specified by our company. For more details, cahigour dealer.

1. ClickSetup> System> Ports & Devics, and then click th&erial Portab.

RS435_1
Port Mode |CsD v|
[] Enable OS50 Report

Baud Rate | 9600 v|
Data Bits |8 v
Stop Bits [1 v
Parity | None v|
Flow Control [None v|

Enable Trans-Channel

2. SelectOSDfrom the Port Mode drop-down list. SelectEnable OSD Repofso OSD data will be
uploaded to the platform).

3. ClickSave
ONVIFTransparent Channel

Transmit data through th&ansparentchannel(ONVIbetween thecamera'sRS485 port and a thirgarty
device.

1. ClickSetup> System> Ports & Devics, and then click th&erial Portab.

RS4385 1
Port Mode [Trans-Channel via ON' v |
Baud Rate (9600 |
Data Bits | 3 v|
Stop Bits |1 v|
Parity [Mone V|
Flow Control | Mone v|

Enahkle Trans-Channel

2. SetPort Modeto Select TransChannel via ONVIF
3. ClickSave

Wiper Control

Setwiper parametersbefore you can control the wiper
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@ NOTE!

This function is not supported by some modélease see the actual model for details.

1. ClickSetup> System> Ports & Devicesand then click th&xternal Deviceab.

Wiper
Control Mode Alarm Input/( V|
Enable Wiper Normally Opi V|

2. Set control mode for the wipef he following table describes some major parameters

Parameter Description

The wiper is controllecdby PELC@ instructions therefore, the PTZ protocol should be st

Serial Port to PELC@. SedPTZontrol for details.
Alarm Use alarm inpuind output to openor close the circuitind control the wiper
Input/Output P P P per.

Viewing Device Status

You can view the current status of your camer
1. ClickSetup>Common> Basic Info

2. Clickrefreshfor the latest status information.
3. View the device information.

PhotoStorage Status

View the current photo storage statuSeeMemory Card Storager the full storage policy.

@ NOTE!

Only models with storage function suppahis function Please see the actual model for details.

1. ClickPhoto.
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e m

Total Capacity 0 MB, Free Space 0 MB.

Image List

= M 1203.3.1.99

(Refresh Export Record| |Export| |Delete| |Export & Delete)

2. ClickRefreshto update thestoragestatus.
3. You can export or delete photos in thleage Listarea.

Upgrading theDevice

If the deviceis managed by the central management server and you want to updhaddevice in batch
mode, it is recommended to perform the upgrade operationtba central server. For detailed steps, see
the user manual for the central management server.

1. ClickSetup> System>Maintenance
Seftware Upgrade

Lecal Upgrade Browse. ..

Cloud Upgrade Detect

2. UnderSoftwareUpgrade clickBrowseand selecthe correct upgrade file.
ClickUpgradeand then confirm to start. The camewill restart automatically after the upgrade is
completed.

4. You may clicbetectto check fomew versions available to cloud upgrade.
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= NOTE!
You must use the correct upgrade file for you cametaerwise, unexpected results may occur.
The upgrade file ia ZIP file and must include all the necessary files.
The boot program loads the operating systenand then the system starts runnindhe upgrade bot
program function is disabled by default, and only the camera will be upgraded to the latest véi

enabled both the camera and the boot program are upgradadd te operating system of the followit
new versioscan be booted properly and the camera can be upgraded conveniently.

Ensure that the power supply is normal during upgradee d@evice will retart after the upgrade
completed.

Restarting the System

1. ClickSetup> System>Maintenance
Device Restart

Restart Restart device

2. UnderDevice RestartclickRestart Thedevicewill restart after you confirm the operation.
@ CAUTION

Perform this operation with caution becausestarting the system interrupts the ongoing service.

Importing and Exporting System Configuration File

Export the current configurations of the camera and save them to the PC or an external storage medium.
You can also quickly restoreonfigurationsby importing backup configurations stored on the PC or an
external storage medium back to the camera.

@ CAUTION
After you perform the Default operation, all settings are restored to factory defaults, except the foll
login password of the systeadministrator, network settings, and system time.

Make sure you import the correct configuration file for your camera. Otherwise, unexpected resu
occur.

The camera will restart when the configuration file is imported successfully.

1. ClickSetup>Sysem > Maintenance

Config Management

Default Restore all settings to defaults without keeping current network and user settings.
Importing Browse...

Exporting Export

2. To import configurations that you have backed up, dickwsenext to thelmport button and select
the configurations you want to import, and then clickport. The result will be displayed.

3. To export configurations, clidkxportand select the destination folder

To restore default configurations, cliflefaultand then confirm the operation. The device will restart
and restore the default configurations.
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Collecting Diagnasinformation

Diagnoss information includes logs andystem configurations. You can export diagaasformation to
your PC.

1. ClickSetup> System>Maintenance

Diagnosis Info

Export

7| Cellect Image Debugging Info

2. UnderDiagnosis InfoclickExportand select the destination folder

= NOTE!
Diagnossinformation is exported to the local folder in form of anapressed file. You need to decompt
the file using a tool such as WinRAR and then open the file using a text editor.

By selectingCollect Image Debugging Infgou candisplay video with debugging information at the se
time, which makesroubleshootingeasier.

Focus Configuration

The device can adjust the speed of afous according to the minimum focus distanbeorder to shoot

clear objects, it is recommended that the minimum focus distance is set shorter than the distance between
the objects and lens, for example, if the minimum focus distance is 3m, then the objects within 3m from
lens will be out of focus.

= NOTE!
This functions only supported by the devices with atitacus Hease see the actual model for details.
1. ClickSetup> System> Maintenance

Fecus
Min. Focus Distance(cm) 10 |z| oK

Mazx. Zoom Ratio 30 [=] 0K

2. UnderFocus configureMin. FocusDistance(unit: cm)andMax. Zoom Ratio
3. ClickOK

Device Mounting Height

Enter the actual height from the installédfrared dome to the ground, sahat the dome will be able to
automatically adjust its infrared lamp.

@ NOTE!

This functions onlysupported by some infraredameras Hease see the actual model for details.

1. ClickSetup> System>Maintenance

Mounting Info

Mounting Height (cm} G600 OK

2. Enter the actual height from the installédfrared Dome to the ground.
3. ClickOK
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Fisheye Camera Parameter

To display video properly, you need tet disheye parameters properly according to the actual mounting
mode.

@ NOTE!

This function is only supported by fisheye cameResase see the actuahodel for details.

1. ClickLive View>Mount. Select thenountingmode. The selected mounting mode must be consistent
with the actual mounting mode.

@ LiveView [ Playback [ Photo £ Setup

Proportional [Scale v | Main Stream | Sub Stream | Third Stream Fisheye Mode

Mount

Vo $
® @ L

" G- - 8 -

For some camera models, the page is displayed as follows.

Live View [ Playback [& Photo 1% Setup

Operation Mode Main Stream | Sub Stream | Third Stream Image Preview Mode

Mount

& @
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2. Set the parametersThe following tablalescribes some major parameters.

Parameter Description
-
KA
3"
Elevendisplay modes:
A . Originallmage
' . Panoamic
- ., Panoramic+3PTZ
Panoramic+4PTZ
— Panoramic+8PTZ
P 360°Panaamic+1PTZ
— . 180°Panoramic
Q . Fisheye+3PTZ
Fisheye+4PTZ
. 360%Panoramic+6PTZ
QH . Fisheye+8PTZ
L
.
e Three mounting modes:
1 Ceiling
N 1 Wall
@
N f Desktop
Note:
_— The selected mounting mode must be consistent with the actual mounting mode
Live View

Live view means playing live video (reale audio and video) received from a camera imiadow through
the Web interface.

If you log in with thelive Viewcheck box selected, live video appears by default when you are logged in.
You may doublelick thewindowto enter or exit full screen mode.
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W LveView [ Playback [ Photo

Live View Toolbar

Proportional Scale [v] | MainStream | SubStream | Third Stream

@ NOTE!

The supported live viewperations may vary with camera model. For the operations that your ce
supports, see the Web interface.

Button Description
n n Play/stop live video.
Adjust the output volume for the media player on the PC.
5 o Adjust the microphone volume onhe PC during audio communicatio

betweenthe PC and the camera.

Take a snapshot of the current image displayed on the PC.

Note:
The path for saving snapshots are geBystem Configuration

Start/stop local recording.

Note:
The path for saving local recordingsetin System Configuration

Start/stop audio communication betwedahe PC and the camera.

Start/stop digital zoom. For more details, ddsing Digital Zoom

Start/stop areafocus For more details, seldsing Area Focus

Start/stop 3D positioning. For more details, $¢sing 3D Positioning

Show/hide the PTZ control panel.

Proportional Scale ]

Set image display ratio in the window. For example, to display-degjhition
images at original 16:9, seleStale to display according to window size, sele
Stretch to display with the original image size, sel@ciginal
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Button

Description

Reset the packet lossteato zero.

Note:

After you move the mouse cursor on a live viewndow, this button appears
on the floating toolbar.

Display packet loss rate and bit rate informatetrthe bottom of the window
Note:

After you move the mouse cursor on a live viewndow, this button appears
on the floating toolbar

Click this button to always displaie information. With another click, the
information appearsonly when you move the mouseursor overthe window
or place itat the bottom.If the mouse cursor restsn the window for around 2
seconds or leavehie window, the information disappears.

Image

Click this button to open the image setting page.

Display in full screen mode.

Main
Sub
Third

Select a live video stream that the camera supports: main stream, sub st
or third stream.

Viewing Certain Area of Images

Digital zoom area focusand 3D positioning allow you to get more details of certain part of im&gigstal
zoom enlarges an image with loss in image qualityile 3D positioningenlarges an imagewithout.

Using Digital Zoom

@ NOTE!

The supported live view operations may vary with camera model. For the operations that your
supports, see the Web interface.

Fant

1. On theLive Viewpage, clicl®d on the toolbar.
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® LiveView [ Playback (@ Photo % Setup

Main Stream SubStream |  Third Stream

2. Click and hold the mouse button, and then drag from top dd@dnaw a rectanglejo specify an area.
To restore the original image size and zoom in on other areas of the imagecliggthe mouse.

3. To exit, clichka.

Using Area Focus

@ NOTE!

The supportedive view operations may vary with camera model. For the operations that your ¢
supports, see the Web interface.

. . . (o]
1. On theLive Viewpage, cI|c on the toolbar.

® LiveView [ Playback (@ Photo % Setup

Proportional [Scale [v] | Main Stream SubStream |  Third Stream

2. Click and hold the mouse button, and then drag from top dddnaw arectangle to specifyanarea.
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3. To exit, clic (=]

Using 3D Positioning

@ NOTE!

This function is available only for network PTZ cameras and network box cameras equipp
motorized zoom lens and PTZ. Please see actual models for details.

1. On theLive Viewpage, cIic on the toolbar.

M LiveView [0 Playback (@ Photo £ Setup

2. Click and hold the mouse button, and then drag from top d@dnaw arectanglg to specify an area.
Dragging reversely (from down top) will zoom out.

3. To exit, cliclm.

Live View of Fisheye Cameras

NOTE!

This function i®nly supported by the network fisheye cameras. Please see actual models for detail

The preview image on the Web may vary with the fisheye settings for the cafease set the fishe
parameters (seefisheg Cameras Paramefeand the fisheye mode (seéideo Configuration of the
camera before you start live view.

Display modes include three major types: Original Image, Fisheye and PTZ, Panoramic and PTZ. In differe
mounting modes, images are displayed differently. The following takes wall mountexsuaple

When Original Image is selected, fishayages are diplayed as follows.
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